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SYSTEM INSTALLATION
Unpacking
When the Series 2040 Windows Test System is shipped from Digalog, it is
wrapped in bubble pack and shrink wrap. When removing this material, take
care not to damage the console. If the unit has been exported, it is usually
mounted on a skid and packed in a carton for protection. The following three
pages illustrate specific areas on the console to be inspected. If any of these
areas are damaged, written notification listing the damage and unit serial
number should be sent to the shipper and to Digalog via FAX. For further
technical assistance, contact Customer Service & Support at (414) 797-8577
(USA.)
After the unit is unpacked, it must be checked for loose connections and
Testhead boards. Proceed as follows:
1. Loosen the four screws on the Testhead cooling fan plate and slide
the panel towards you 2 to 3 inches. (See Figure 1 below).
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Accessory Power
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Figure 1 - Rear view
of tester.

AC Power Inlet
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2. Loosen the two Testhead retaining screws located along the back of
the black Testhead cover by turning them 1/4 turn counterclockwise.
Using the handle, lift the Testhead into the position shown below.
(See Figure 2).
3. Physically push in each circuit board using the white tabs on the
edges of the boards to ensure all of the Testhead boards are secure.
Retaining screws
and handle
Testhead Boards

Figure 2 - Side
view of tester

4. Check the UUT power supplies and controllers (if present) and
Testhead Power Supply Controller for loose wiring by removing the
back panel as shown in Figure 1 and physically inspecting the power
and fault loop cables and connections.
5. Check all of the computer, Testhead, and accessory power cables
and their connections.
6. When the above areas have been inspected, reinstall the back
panel, Testhead, and cooling fan panel.
7. Check the I/O panel on the right rear corner of the unit for damage.
(See Figure 1 and/or page 34.)
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Monitor
When the above inspections are complete, locate the monitor and unpack it.
Make sure the monitor power switch is turned off. If the tester has the
optional shelf assembly, place the monitor on the shelf as shown in Figure 3. If
not, place the monitor on a convenient place close to the tester. Locate the
DB15 connector on the I/O panel on the back of the unit and plug the
monitor video cable into it. The power cord for the monitor plugs into any of
the accessory outlets on the rear of the machine.
Keyboard
If the console has a keyboard drawer, lift up the drawer using the inset handles
and rotate the drawer towards you. The keyboard should be present. If not,
unpack the keyboard, and plug its cable into the keyboard port on the I/O
panel.
Printer
If the optional printer was shipped with the unit, unpack it and place it on the
top of the unit next to the monitor (or a convenient place close to the tester).

Monitor

Printer

Shelf

Figure 3 - Optional
locations for
components
Keyboard

Series 2040D Test System

7

Installation Manual V1.0

Series 2040D Test System

Make sure the printer is turned off. Locate the power cord supplied with the
printer. Insert the receptacle end into the printer’s power inlet as shown in
Figure 4, and the other end into one of the Accessory power outlets. Locate
the printer’s data cable. Plug one end into the 36-pin Centronics connector
on the rear of the printer as shown in Figure 4, and the other end into the
“Printer” port on the I/O panel. Ensure that the retention clips for each end of
the Centronics connector are fully engaged. Install the paper into the printer
using the tractor feed setting. Consult the printer’s OEM manual for additional
details.
Figure 4 - Back of
printer

Power

Centronics connector

Mouse
Locate the mouse and mouse pad. The pad is generally placed on the right
side of the monitor for right-handed operators. Plug the mouse cable into the
Mouse port on the I/O panel
Figure 5 - Bottom of tester
for skirt installation

Locating pins

Figure 6 - Side view of tester
showing skirt installation

Skirts

Skirts
The eight locating pins, shown in Figure 5, are on the bottom of the Series
2040 Test System. Lay the skirts on the ground under the tester, snap the two
skirt halves together, and then snap the assembly to the bottom of the tester
using the locating pins.
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Oscilloscope
The display oscilloscope is another optional piece of equipment. Make sure
that the oscilloscope is turned off. Locate the power cord and install the
receptacula end into the oscilloscope. Plug the other end into one of the
Accessory power outlets,
The oscilloscope is shipped with a set of three scope cables. Fifty-ohm
attenuators (PN#2100-7014) are provided for the X and Y axis cables, and a
special attenuator assembly (PN#0000-0068) is provided for the Z axis cable.
Connect the attenuated ends of the X, Y, and Z scope cables to the
oscilloscope. The X channel corresponds to the channel 1 input, and the Y
channel corresponds to the channel 2 input. The Z channel is generally
located at the rear of the oscilloscope and is clearly marked.
The three signal outputs from the
Series 2040 Test System originate
at the Testhead and are routed
out to the I/O panel as shown in
Figure 7.
Connect the other end of each
scope cable to its labeled connector
on the I/O panel. The following
front panel settings for the
oscilloscope are necessary:

X

Y

Z

Figure 7
Top of I/O panel

1) Set the Time/Division knob to X-Y (or CH3). Verify that its VAR
knob is fully pushed in and set to the “Calibrated” position.
2) Set the Coupling switch to DC.
3) For both channels 1 and 2, set the switch for input coupling to DC.
4) For both channels 1 and 2, set the vertical range to 0.2 Volts/
Division. Also verify that the VAR knobs are fully pushed in and set
to the “Calibrated” position.
To adjust positioning within the display once power has been applied, ground
channels 1 and 2 by setting their respective input coupling switches to GND.
Rotate their vertical position knobs to move the beam to the leftmost time
division and to the second voltage division from the top of the screen. Then
set the input coupling switch for each channel back to DC.
Series 2040D Test System
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POWER-UP & SYSTEM UTILITIES
The system is now ready to be powered up. All of the accessories (monitor,
printer, and oscilloscope) should be plugged into the Accessory power outlets.
Turn each one on. Loosen the retaining clamp on the AC power inlet, which is
located next to the Accessory power outlets as shown in Figure 1. Insert the
receptacle end of the AC power cord supplied with the console into the AC
power inlet, and tighten the retaining clamp. Plug the other end into the
appropriate AC power source as indicated by the label above the AC power
inlet.
Rotate the red “Emergency Stop” button located in front of and to the right of
the Patchboard receiver clockwise one-quarter of a revolution until it pops up
(approx. 3/16” or 4.8mm). This button is to be fully depressed during an
emergency situation or after the three front panel power switches have been
turned off during the normal shutdown process in order to turn off all power
within the console. Deactivating only the three front panel switches does not
remove power from the Power Distribution Box. When the “Emergency Stop”
button is depressed, it breaks the AC input power connection within the
Power Distribution Box, and thus all of its power outlets are inactive.
The three switches on the front panel of the 2040 computer are (from left to
right) for Testhead power, accessory power, and computer power. Turn on the
three power switches sequentially from left to right. The computer will boot
up and execute its operating system software. You may be requested to enter
a password for access. The default password setting for the Administrator
account is set to “password” (without the quotes) at the factory. The unit is
now ready for use.

Note: If the unit does not up boot into its operating system, call the
Digalog Customer Support Helpline at (414) 785-8777.
CONSTAT (CONSOLE STATUS)
Constat is a program designed to give the user a variety of information about
the hardware modules that make up the Series 2040 Test System. It provides
the user with the contents of the EEPROMs on the Testhead boards.
Every Testhead board in a Series 2040 Test System has an EEPROM which
10
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stores that board’s history. Information such as the Digalog Part Number for
the board, a board description, ECO levels and installation dates, and RMA
dates is contained in the EEPROM. Constat enables the user to display or print
all of the information stored in the EEPROMs. This data informs the user to of
the names, quantities, and locations of the boards in the Testhead (such as
which slot a particular Analog Source Board occupies). It also helps in
reporting troubles to Digalog Systems with a given board since its history in
terms of repair and ECOs is available with only a few mouse clicks. When
Constat is executed from the Digalog program group, the Console Status
dialog shown in the example in Figure 8 below is displayed.

Figure 8 - Constat console status

To select a slot, simply use the mouse to select the name of the desired slot,
such as Slot 4, AMS, or Selftest. Slots are numbered from 0 to 23 with the
AMS, TMS, and MDE boards in the measurement section of the Testhead as
shown on page 33. Although the Selftest unit is physically mounted on the
Patchboard receiver, it is also read by the Constat program. After selecting a
slot, the information for the selected board will be displayed using the “Board
Status” dialog shown in the example in Figure 9 on page 10.
When the “Read All” button is selected, the program reads every slot in the
Series 2040D Test System
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Testhead and displays the current contents of the Testhead in the “Console
Status” dialog. This routine also reads the Selftest Assembly if it is installed.
The Information can be printed by selecting the “Print Console” option from
the File menu.

Note, the shipping date is contained within this information. This
data is used to determine whether a board is still under warranty
or not. The user can easily determine if a board is still covered for
warranty repair by checking the shipping date with Constat.
(Digalog warrants all boards for a period of one (1) year from the
date of shipment).

Figure 9 - Constat board status

The RMA LIST is a list of Return Material Authorizations issued and processed
for that board. Every time that a board is returned to Digalog for repair, this list
is updated.
12
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If the information from the “Board Status” screen (Figure 9) needs to be
printed, use the “Print All Info” selection under the File menu. The “Printer
Setup” option from the File menu is the standard Windows 95/NT printer
setup routine that is common to all Windows 95/NT applications.
SELFTEST
Selftest on the Series 2040 Test System is an automated procedure. The
programs that comprise Selftest are organized under the Selftest Executive in a
test menu called “Functional.” These programs exercise the hardware
functions available to the user through the functional calls. To perform Selftest,
proceed as follows:
1) Install the Selftest unit on the Patchboard receiver assembly as
shown below:

Figure 10 - Selftest Installation

Figure 11 - Selftest Installed

A) Pull the locking handle towards the front of the unit until it is
completely vertical.
B) Slide the pins on the rear of the Selftest unit into the
Patchboard receiver as shown in Figure 10, and rotate the
Selftest unit forward until it is fully seated in the Patchboard
receiver.
C) Install the Selftest data cable into the receptacle behind the
Selftest unit with the colored edge of the ribbon cable on the
left side (opposite the locking handle).
D) Rotate the locking handle back to a completely horizontal
Series 2040D Test System
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position to lock the Selftest unit into place as shown in Figure
11.
2) Enter the Selftest Executive by selecting (double-clicking on) the
“SelfExec” program from the Digalog program group. The Selftest
Executive menu will be displayed as shown in Figure 12 below.

Figure 12 - Selftest Executive Menu

3) From the File menu, select Configure, and the “Report Utilities”
dialog box in Figure 13 on the next page will appear. This dialog
controls three separate ways of reporting the data collected during the
tests. Data may be stored to a file, displayed on the screen, and/or
printed.
In addition, each of these three reporting functions can report “All
Data”, “Fail Data” or “No Data”. “All Data” includes all of the pass or
fail sequences from the test. “Fail Data” includes only information on
the tests that failed. “No Data” disables that reporting function. To
14
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select, merely use the mouse to check
or uncheck each reporting function. If a
reporting device is unchecked, the
options under that device appear
“ghosted”, indicating that they are
disabled. For the purposes of
installation, enable the “Printer” and
“File” options, and select the “Fail Data”
option. Under the “File” section, click
the “Diagnostic File” check box. Disable
the Window reporting functions by
selecting the “No Data” option box.
Figure 13 - Executive Configuration

4) Once the type(s) of reporting is
completed, click on “OK” to return to the Selftest Executive menu.
Select “Functional” from the Selftest Executive screen, and the
Functional menu will appear as shown below.

Figure 14 - Functional Tests (Typical Configuration)

Series 2040D Test System
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The Functional test menu has been organized so that tests closely
related to each other are blocked together in groups. If only one test is
to be run, use the mouse to select that particular test. If a related group
of tests is to be run, they may be selected using only the mouse. For
example, if the Measurement Display Electronics group is to be
selected, place the mouse pointer on test #30 and hold the left button
down, and drag the mouse down to test #38. The entire MDE group is
now selected. If a random series of tests is desired, place the mouse
pointer on the box labeled “Test Sequence”. When the Windows text
tool appears, click the left mouse button. At the blinking cursor, any
sequence of tests can be entered. The test numbers, however, must
follow this syntax:
‘E’ (Execute) signifies the beginning of a sequence or acts as a separator
between sequences.
“:” (Colon) signifies that the following number indicates the amount of
iterations to perform of the previous sequence.
‘,’ (Comma) shares the definition of ‘E’ as a separator between
sequences.
‘-’ (Dash) signifies inclusive or ‘through’.
EXAMPLE: E1-3:5,6-100:2,1-5
This sequence executes tests 1 through 3 five times, tests 6 through
100 two times, and tests 1 through 5 once. Click on the “Run
Sequence” button to execute the sequence entered in the textbox.
If a single test or a group of selected tests is to be run once, 10 times,
or 100 times, use the mouse to select the appropriate button on the
upper left. If the test or group is to be run at some other number, place
the mouse pointer in the box to the direct left of the stop button, and
the Windows text tool will appear. Click the left mouse button while
text tool is displayed in the box. A blinking cursor appears, and the
user can enter any number from 1 to 999 for the number of times a
test should run.
For the purposes of installation, click the mouse button on the check
box in the upper left corner of the menu next to “All Tests”. Select the
“1" button, and the program will run all of the functional tests once,
16
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Figure 15 - All tests

5) If any of the Functional programs fail, check these common
problems:
SELFTEST ASSEMBLY IMPROPERLY INSTALLED - Check to make sure the
assembly is properly installed on the Patchboard receiver. Also, check the
Selftest assembly’s cable for damage.
UUT POWER SUPPLIES OFF - Make sure the UUT Power Supplies are on.
TESTHEAD POWER SUPPLY FAULT - Check the Testhead Power Supply
Controller’s indicator LEDs. If any of the LEDs are not lit, reset the system
by cycling the Testhead power switch off and on and recheck.
MISALIGNED PINS ON PATCHBOARD RECEIVER - Remove the Selftest
Assembly and carefully inspect the alignment of the Patchboard receiver pins.
Adjust any pins that are misaligned, remount the Selftest Assembly, and
retest.

After the common problems have been eliminated, a failure in
Functional Selftest can indicate a hardware problem. Since a failure in
Functional Selftest could also be caused by calibration, recalibrate the
unit and run Functional Selftest again. If calibration or Functional
Selftest fails now, a hardware problem most likely exists.

NOTE: Refer to the Selftest Failure Analysis sheet and the STEX routine at
the end of the calibration section.
6) Whenever a Testhead board is replaced, or anytime that Selftest
determines a failure, a calibration must be performed. If a unit passes
the complete Functional Selftest routine, a calibration is not necessary.
When “Calibrate” is selected from the Selftest Executive, the screen
shown in Figure 16 on the next page is displayed.

Series 2040D Test System
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Figure 16 - Selftest Calibration

The Calibrate menu operates under the same basic rules as the
Functional menu. For installation purposes, use the mouse to select the
“All Tests” check box, and select the “1" button for the number of times
to be run. (See page #14). Since the Printer and Fail Data were
selected previously, any failures from the calibration routines will be
printed automatically.
The following is a list of the calibration programs located in the Calibrate
menu in the Selftest Executive along with the three most likely boards or
assemblies that could cause failures:
Test Name
#1 AMS_RMUX_c
#2 AMS_SIG3_c
#3 AMS_DIFF_c
18

#1
AMS
AMS
AMS

#2
RMUX
MSP/ISO
RMUX

#3
MSP/ISO
RMUX
ICAM
Series 2040D Test System
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#4 DMS_c
#5 ARB_v_c
#6 DA_v_c
#8 DIO_c
#9 ADIO_c
#10 ADIO_dac_c
#12 MDE_c
#13 MDE_TGDC_c
#15 POWER_c
#17 ISOAmp_c

Installation Manual V1.0

DMS
ASB
MSP/ISO
ASB
MSP/ISO
DIO
TH CONT/CPU
ADIO
TH CONT/CPU
ADIO
AMS
MDE
TMS
MDE
TMS
UUT Cont
AMS/RMUX
MSP/ISO
AMS

AMS
AMS
Selftest
Selftest
RMUX
AMS
AMS
Selftest
RMUX

Any type of failure during calibration could indicate a hardware problem. If a
failure during Functional was the reason that a calibration is being run, refer to
the Selftest Failure Analysis sheet on the next page.

Series 2040D Test System
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Selftest Failure Analysis
1)
2)
3)
4)
5)
6)
7)
8)
9)
10)
11)
12)
13)
14)
15)
16)
17)
18)
19)
20)
21)
22)
23)
24)
25)
26)
27)
28)
29)
30)
31)
32)
33)
34)
35)
36)
37)
38)
39)
40)
41)
42)
43)
44)
20

Test Name
SELF_dig-f
th_config_tst
ams_dig_f
ams_mode_f
ams_sig3_f

#1
#2
#3
Selftest
TH Cont/CPU TH P/S Cont
Testhead configuration does not match the stored configuration.
AMS
TH Cont/CPU TH P/S Cont
AMS
MSP/ISO
ASB
AMS
MSP/ISO
TH P/S Cont

arly_dig_f
arly_f
afet_rft_f

Arly/AFET
Arly/AFET
AFET

TH Cont/CPU
RMUX
RMUX

TH P/S Cont
AMS
AMS

mrly_dig_f
mrly_f

MRLY
MRLY

Selftest
RMUX

TH Cont/CPU
AMS

rmux_dig_f
rmux_f
rmux_prt_f

RMUX
RMUX
RMUX

TH Cont/CPU
AMS
AMS

TH P/S Cont
Selftest
MDE

arb_mem_f
arb_brst_f
arb_ext_f
arb_freq_f
arb_mon_f
arb_ref_f
da_ref_f

ASB
ASB
ASB
ASB
ASB
ASB
ASB

TH Cont/CPU
AMS
AMS
AMS
AMS
AMS
AMS

TH P/S Cont
MDE
MDE
MDE
MSP/ISO
MDE
MSP/ISO

mde_dlmd_f
mde_dltm_f
mde_expm_f
mde_freq_f
mde_mrkp_f
mde_msmk_f
mde_pmes_f
mde_tgfl_f
mde_tglv_f

MDE
MDE
MDE
MDE
MDE
MDE
MDE
AMS
AMS

TMS
TMS
TMS
TMS
TMS
TMS
TMS
MDE
MDE

AMS
AMS
AMS
AMS
AMS
AMS
AMS
TMS
TMS

tms_dig_f
tms_evnt_f
tms_test_f

TMS
TMS
TMS

TH Cont/CPU
MDE
MDE

TH P/S Cont
AMS
TH P/S Cont
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45)
46)
47)
48)
49)
50)
51)
52)
53)
54)
55)
56)
57)
58)
59)
60)
61)
62)
63)
64)
65)
66)
67)
68)
69)
70
71)
72)
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dio_f
dio_ext_f

DIO
DIO

Selftest
Selftest

TH P/S Cont
TH P/S Cont

iamp_dig_f
inst_f
amp_cmrr_f
isoamp_f

INST
INST
INST
MSP/ISO

TH Cont/CPU
ASB
RMUX
ASB

TH P/S Cont
AMS
AMS
AMS

pwr_mon_f
ptest_f
th_iso_f

Power Supply TH P/S Cont
MSP/ISO
UUT Controller AMS/RMUX
Selftest
Scope Connected?
Internal coax short?

msp_ser_f

MSP

TH Cont/CPU

TH P/S Cont

ocio_dig_f
ocio_f
ocio_rail_f

OCIO
OCIO
OCIO

TH Cont/CPU
Selftest
Selftest

TH P/S Cont
TH Cont/CPU
TH Cont/CPU

adio_f
adio_ext_f
ams_int_f

ADIO
ADIO
AMS

Selftest
Selftest
MDE

TH Cont/CPU
TH Cont/CPU
TH Cont/CPU

dms_dig_f
dms_mem_f

DMS
DMS

Selftest
TH Cont/CPU

TH Cont/CPU
TH P/S Cont

psc_dig_f

PSC

Any other Trigger Matrix board.

Series 2040D Test System
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Self Test EXaminer (STEX)
Overview
The STEX program may be used to help graphically interpret the
results of any diagnostic output file generated by the Selftest Executive
program run on the Series 2040D testers. STEX uses the results of the
diagnostic output file to show the configuration of the tester and evaluate
possible problems with the tester resources based on failed test data and/or
system errors encountered during testing. STEX will use these results to
determine what the top three most likely resource problems are in the tester,
based on Selftest output information. These results will be shown graphically
on the STEX interface.
STEX can be very useful in aiding an operator who is troubleshooting possible
problems in the Digalog testers by providing a graphical depiction of the
location of potentially faulty tester resources. These resources include all
Testhead boards, the Testhead power supplies, the UUT power supplies and
their controller modules, GPIB devices, the computer with its Testhead
interface card, and the Selftest assembly itself.
Creating the Diagnostic File for STEX
To use STEX to analyze Selftest data, the proper information must first be
recorded in the Selftest output file. To obtain a diagnostic file for use in STEX,
follow these steps when running the Selftest Executive:
1) Under the ‘File’ menu, select ‘Configuration’.
2) On the configuration form under ‘File
Options’, select either ‘Fail Data Only’ or ‘All
Data’ and select ‘Diagnostic File’.
3) Run the desired calibration and function
tests.
Selection of the ‘Diagnostic File’ option for file
output will create a file with all the information
required by STEX to analyze the system. This
information includes the tester type being run, a
listing of the Testhead resources as recorded in the
22

Figure 17 - Configuration
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‘resource.ini’ file or the Registry, and a listing of all tests run along with any
problems encountered during the tests. These results will be written into a file
in the ‘digalog\bin\’ directory. The filename is the date on which the test was
run with the file extension ‘.dxx’, where ‘xx’ is an incrementing number
starting at ‘01’ and going through ‘99’. For example, if the diagnostic file was
written on January 20, 1997, the file name would be ‘jan2097.d01’. If a
second file were created on the same day, its name would be ‘jan2097.d02’,
and so on. The first diagnostic file written each day would carry the extension
‘.d01’. If the file option is not set to ‘Diagnostic File’ and the ‘File’ reporting
function is still enabled, the file extension would not contain a ‘d’ such as
‘.001’, ‘.002’, and so on. These files do not contain the configuration
information required by STEX and will not be accepted as proper files for
analysis by STEX.
Analyzing Selftest Data
When starting the STEX program, the graphics show the Testhead as being
empty. Under the menu item ‘File’ are the selections: Open for EXam, View
Log File, Report Details, Close, and Exit.
Open for EXam - Selecting this menu item opens up a
file selection window showing the files available in the
‘digalog\bin\’ directory with the ‘.dxx’ file extension.
Highlight the desired filename and Click on the ‘Open’
button to select for analysis under STEX. STEX will then
open that file, and examine it to see if it is a valid file
for this program. If the file is not valid for STEX, a
message box will inform the user of this, and the
graphics will return to their default condition. If it is
Figure 18 - File Menu
valid, the tester resource information will be read in
for analysis. The boards listed in the Registry will be placed in the proper slots
in the Testhead graphic and the file will be inspected for any fail data from the
tests listed. If fail data or system errors are found, the program will analyze
those results using information about the tests located in the STEX database —
‘digalog\include\stex.mdb’. The program will then use this information to
calculate the three most likely tester resources that could cause the problems
found in this diagnostic file.
All tester resources by default are displlayed either in gray or on gray
background. The one to three resources calculated to be most likely causing
Series 2040D Test System
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the fault(s) will be highlighted in red. Also, the ‘Results:’ box on the lower
portion of the form displays the available information regarding these three
tester resources as shown in the example of Figure 18. If the resource is a
board in the Testhead, an arrow with a number 1-3 according to its level of

Figure 19 - Results Window

probability (1 being greatest) will point to the location of the board. An
information box with the same number will display the board’s description,
Digalog part number, and serial number (if this information is available in the
diagnostic file.) If the tester resource is not a board in the Testhead, the
resource’s graphic will be highlighted in red with a label indicating which
‘Choice #’ it is in relative importance. The information box with the ‘Choice
#’ information will have the resource’s description and other optional
information regarding that resource.
If the functional test ‘TH_config_test’ has logged any failures in the current
diagnostic file, a message box will be shown informing the user that this fault
exists. Also, the ‘Results:’ box will display the message: “Config problems
found” on a red background. The configuration of the Testhead will be
displayed, but no specific tester resources will be tagged as being at fault as a
result of this file’s analysis. The test ‘TH_config_test’ examines and compares
the contents of the Testhead to the recorded listing in the Registry. If a
discrepancy exists, it cannot be automatically known where the source of the
problem is without further investigation. Therefore, the user should refer to
the Tester Resource Manager (TRMAN) section of this manual to proceed in
troubleshooting this problem.
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If any failure(s) or problem(s) are found in a valid diagnostic file, the menu
item ‘Report Details’ will be enabled to show some details about those tests.
See the section entitled ‘Report Details’ for more information.
If the diagnostic file is examined, and no failures or other problems were
found with this test, the ‘Results:’ box will display the message: “No Problem
Found” on a green background. The proper configuration for the Testhead
will be displayed, but the menu item ‘Report Details’ will be disabled, since
there are no failing tests on which to display information.
View Log File - Choosing this menu item opens a file selection window
showing all of the available files in the Digalog\bin directory with the “.dxx”
file extension. Selecting a filename here will start the Microsoft Windows text
editor program ‘WordPad’ and open the diagnostic file for viewing. This
allows individual test results to be viewed to provide further possible insight
into any problems with the tester.
Viewing the individual failures of a test may aid in troubleshooting an
individual board. Examining all system error messages and referring to
documentation for the source and/or meaning of the error may also help in
resolving the problem with the tester resources. While viewing this file, the
user may elect to print the file contents.
IMPORTANT: The file being examined SHOULD NOT be edited. Changing
any information in these files will render the information inaccurate or useless
for diagnosing any problems with the tester.
Report Details - This menu item is only available while there is a valid
diagnostic file with fail information opened for examination.
Selecting this menu item will
bring up a separate window
with a list of the failed test
programs as shown in Figure
20. This list gives the name of
the Selftest program which
Figure 20 - Report Details
detected the problem, the slot
number of the board being examined by that test, and whether the problem
was a test failure or a system error. If a test result does not contain any slot
Series 2040D Test System
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information, the slot value will be listed as ‘Unknown’. To view the details of
each individual failure or system error number, select the ‘View Log File’
menu item. Refer to the Selftest documentation to aid in interpreting these
test results.
Close - Selecting this menu item closes the current diagnostic file and clears all
information from the program’s windows. This returns all tester resources to
their default condition, clears the Testhead board configuration, and removes
any individual test results from the ‘Report Details’ window. This menu item
is provided only for the convenience of the user. It is not mandatory to ‘Close’
one diagnostic file before opening another for examination.
Exit - Selecting this menu item closes the current diagnostic file and terminates
the program.

Figure 21 - STEX Interface
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TRMAN (Tester Resource Manager)
The Tester Resource Manager is used to track and manage the tester resources
including all the boards in the Testhead and the UUT power supplies.
Information about these resources can be automatically generated or manually
defined, and is used to generate a Patchboard Interface Map and define the
pin locations of these resources at the Patchboard. This information can be
saved to a project specific file called resource.ini and can be used by other
Digalog System’s applications.
Specifically, the software is capable of printing out a “Patchboard Map”
containing Patchboard pin mnemonics by either automatically interrogating
the tester for its resources, or by asking the programmer to define the tester’s
resources. When the configuration is performed manually, it allows the
programmer to configure additional resources beyond what the tester
physically contains. In this manner, a programmer has the additional resources
to generate programs and fixtures for any tester.
Menu Bar
File Menu - The TRMAN File menu is similar to the standard Windows file
menu. It has selections for a New
configuration, Load an existing
configuration, Save a configuration,
Save an existing configuration As
another file, and Exit. The Print Utility
will be discussed later in this section.
For the purposes of this explanation,
the file being used for illustrations is
the standard resource.ini file in the
Figure 22 - File Menu
\Digalog\include\ directory.
Options Menu - When the Options menu is selected, a pull-down menu will
be displayed prompting for a choice of the following: Automatic generation,
Link to tester, Manual Generation, View pin Definitions, and View Testhead
configuration. Each of these options, along with the Print utility from the File
menu, will be briefly discussed.
Link to Tester - This item will toggle the link between the application
Series 2040D Test System
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and a tester. When checked, the
application assumes a Testhead is
present and enables Automatic
generation. When using Tester
Resource Manager on a development
computer that is not connected to a
Digalog tester, this item should never
be checked as it could lead to
corruption of certain memory
locations.

Figure 23 - Options

Automatic Generation - If Automatic Generation is selected, the
program scans the tester for its resources, and then updates the map of
the Patchboard as shown in Figure 24 below. Tester resources required
to generate the Patchboard map plus any other tester resources can
also be saved to a resource file on the hard drive (resource.ini) stored
in the Registry, or printed out.
All programmers writing code for the system should be familiar with
this map, since it is the actual physical configuration of the
Patchboard.

Figure 24 - Patchboard Map
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Manual Generation - If Manual generation is selected, the screen
below will be displayed. Note that the Power Supply Distribution
board is always in slot 0 and therefore does not show in the Testhead
configuration table. From this utility, any system configuration may be
generated. It is the users responsibility to make sure the generated
configuration is valid.

Figure 25 - Manual Generation

The Programmable variable power supplies (maximum of five) may be
defined in terms of maximum voltage and current once a
Programmable Power Supply is selected (up/down button). With Volts
or Amps selected, the jog shuttle located to the right modifies the
selected value. The option buttons under the jog shuttle control
determine what position in the serial loop that the supply being
defined occupies. However, the variable supplies must be filled in a
contiguous manner from #0 to #4. The spin control on the upper left
corner of the dialog is used to determine which programming channel
is being configured.
Series 2040D Test System
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If a GPIB or HPIB power supply is being defined or added, the channel
and type can be selected and the upper right of the dialog changes to
allow the programmer to select a power supply type, a GPIB/HPIB
Device number, and what Relay Control board will be used. The spin
control on the middle left of the dialog (Patchboard Connection) is
used to define which of the five Patchboard connections are connected
to which supply, or if a GPIB/HPIB supply will use an external output
(i.e. the supply’s output does not physically appear on the Patchboard.)
The rest of the Testhead is displayed in table format by slot number.
The Description and Board Number drop-down menus are directly
linked to, and will modify the table. The Clear All button will clear all
configuration items.
Board Codes are specific identifiers for the particular type of board
selected for that slot. Board Numbers are used to define the resources
of that particular board. For example, if there are two of the same type
of board in the system, board numbers zero and one, the resources of
board one will be numbered over and above those of board number
zero. In other words, for a Relay Multiplexer Board containing sixtyfour channels, board zero channels would be labeled zero through
sixty-three and board one channels would be labeled sixty-four
through one hundred and twenty-seven.
The table is directly linked to the slot drop-down menu, therefore any
slot changes in either place will be reflected in the other.
View Testhead Configuration - This utility displays the entire Testhead
configuration in an organized format. An example of a typical Testhead
configuration is shown in Figure 26 to the right.
View Pin Definitions - This utility from the Options menu explains the
mnemonics used in the Patchboard map as shown in Figure 27.
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Figure 26
Testhead Configuration

Figure 27 - Pin Definitions
Series 2040D Test System
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View Power Supply Configuration - If this option is selected, a grid is
displayed showing all of the power supplies present, along with the
type, name, device designation, and Patchboard connection for each
supply as shown in Figure 28.

Figure 28 - Power Supply Configuration

Print Utility - When this utility is selected from the File menu, a small
inputbox is displayed prompting for a specific serial number for the
printout to be generated. If a specific tester’s configuration is to be
generated, enter the serial number in the textbox. If not, merely select
the OK command button, press <Enter> on the keyboard, or select
Cancel. After this inputbox is satisfied, select an individual printout to
be generated, or select all three options.
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SYSTEM SPECIFICATIONS (Dual Dimensions)
Dimensions:
Width ..................................................................................... 30.6 in/77.7 cm
Depth..................................................................................... 36.5 in/92.7 cm
Height ............................................................................ 50.375 in/127.95 cm
Height to table top ............................................................. 38.25 in/97.16 cm
Product Power Supply Weights:
Kikusui PAD L Type 13 Series ...................................................... 52 lb/23.6 kg
Kikusui PAD L Type 0 Series ........................................................ 23 lb/10.4 kg
Hewlett Packard Series 664xA ................................................. 31.4 lb/14.2 kg
Sorenson LHP Series ..................................................... approx. 12.4 lb/5.6 kg
System Operating Environment:
Operating temperature ................................................... 10 - 35o C/50 - 95o F
Humidity ........................................................... 20% to 80% relative humidity
System Power Requirements:
Voltage .............................................................................. 120VAC - 50-60Hz
Current .................................................................................................. 3.5 A
Oscilloscope:
Voltage .............................................................................. 120VAC - 50-60Hz
Current .................................................................................................. 0.5 A
Monitor:
Voltage .............................................................................. 120VAC - 50-60Hz
Current ................................................................................................ 0.66 A
Printer:
Voltage .............................................................................. 120VAC - 50-60Hz
Current .................................................................................................. 0.4 A
Product Power Supply Power Requirements:
The Series 2040 Test System can be equipped with many different types of
UUT programmable power supplies including GPIB and HPIB supplies. For
the power requirements of a specific power supply, consult the manufacturer’s
documentation.
Series 2040D Test System
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WARNING LABELS:

A

CAUTION
Disconnect power before opening enclosure.

This label means that all power to the unit must be disconnected before the
power distribution box is opened.

CAUTION
USE OUTLETS
FOR TESTER
ACCESSORIES ONLY

B

This label means that the outlets on the rear of the tester are for the tester
accessories only and should not be used for miscellaneous shop tools or
appliances.

C
This label means that power is exposed whenever the Patchboard and/or
power supplies are on and no fixture is installed on the Patchboard receiver.
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WARNING LABEL LOCATIONS:

A
Top of Power Distribution Box

B

X

Y

Z

10M HZ EXTC LK EXTEVENT

GPIB

PRINTER

ETHERNET

C OM 1

KEYBOARD
M ODEM

Back of Power
Distribution Box

Front of Patchboard

C
(Top of Tester)

Series 2040D Test System

35

Installation Manual V1.0

Series 2040D Test System

Testhead

36

Series 2040D Test System

Series 2040D Test System

Installation Manual V1.0

X

Y

Z

10M H Z EXTC LK E X TE V E N T

G P IB

P R IN T E R

ETHERNET
MODEM
KEYBOARD

MOUSE

COM3

COM4

COM5

COM6

COM1

I/O Panel
(Rear Of Tester)
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